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I . Getting Started 
 
Use the Project wizard to walk through the creation of a new project.  If the wizard does 
not open when you start up the program, then navigate to File/New.  Starting an Aguared 
project can proceed in two ways: from data exported from EPANET or from fresh data 
from GPS units.   In this manual we will only address the later. 
 
When creating a new project from GPS data, there are three sets of data which can be 
imported from the GPS unit: 

1. Trackpoints 
2. Waypoints (Optional) 
3. Correction for the Trackpoints (Optional) 

 
From GPS unit:  
The data can also be loaded from previously 
imported GPS data saved in files. Example:  
 
In this window, COM1 indicates the serial port of 
the computer. (Future versions of Aguared will be 
able to handle USB connections as well).  Check the 
export Trackpoints/Waypoints checkbox if you want 
to save the GPS data in text files (always 
recommended; can be used by other projects). If 
there are no waypoints to be imported, be sure to not 
check the checkboxes. 
 



Click Begin once you have made the changes to start importing information from the 
GPS unit. 
 
Loading GPS data from Text files: 
 
This is quite straightforward and involves only loading the files from your hard disk/ 
other memory storage. 
When converting the survey data to the network, the default options are useful because it 
helps the program to generate the network and eliminating repeated survey points  and 
connecting the points based on their times stamps which requires that the survey be 
conducted on that basis to accommodate this. 

 

 
 
Correction of trackpoints can be done subsequently at a later stage in a project as well 
from the Tools menu. 
 
I I . Manipulation of the Network 
 
Once when a network has been created, Aguared displays it in the following manner, on 
the right side is the display window which has the network drawn in it. The user can 
toggle what kind of information that they would want displayed by clicking View on the 
top toolbar. The View menu can also be used to switch to a side projection view which 
will enable the user to see the network and study the altitude changes. To move around 
within the display window bring the focus onto it by clicking on it and then one can pan 
by using the arrow keys and zoom in and out by scrolling using the wheel in a mouse. 
 



 
 
Alternatively one can zoom in and out using the buttons provided on the lower left side. 
The grids are marked according to fixed distance and the colored points mark nodes with 
different colors signifying a type of node. ( Yellow: Reservoir; Red: Junction; Light Blue: 
Tank; Green: Taps; Dark Blue: Valves) 
 
On the right side we have tabular information about the network arranged in tabs. We can 
select multiple elements and make group edits by selection from the table or from the 
grid. For example here we are group selecting three nodes which can be subsequently 
modified by right clicking and selecting “Edit Selection” . It is also possible to order the 
different columns in the data grids by clicking on the column headers. One can also use 
the maximized view of the data from View  menu, selecting “View Data”  
 

  
 

Toggling between the   and  buttons enables selection within the grid on the basis 
of nodes or pipes. We can examine the properties of the pipes by again right clicking on 
the pipes. 
 



Using the   buttons, design modifications can be made to the network graphically 
which will allow the user to create pipes and nodes. To delete a elements is also simple, 
allowing the user to select and then pressing the delete button. 
 
I I I . Materials Database and Global Settings 
 
The Materials database can be accessed by going to the Materials menu and selecting 
“Edit Materials” .  

 
 
The materials database initially contains some default values which can be easily 
modified. All the data is shown using SI units unless specifically mentioned. Within the 
materials database one can Add, Edit and Delete materials as well as toggle their 
availability which will prevent the use of that material in designs created by the Aguared 
(for example with the Transmission line). The Materials Database is organized into tabs 
which consist of Pipes Materials, Tanks, and Valves and Taps which can be modified for 
different projects. 

 



 
 

Global settings can be made to the project by enabling certain materials within the project 
by going to the Edit menu and then going to the Materials tab in the “Project Preferences”  
section. 
 
IV. Exporting the Network 
 
The network can be exported to the EPANET format enabling it to be run with the 
EPANET software by selecting the “Export to EPANET” option in the Export section of 
the File drop down menu. This can be particularly useful since EPANET is not able to 
import GPS data directly.  Also some errors reported by the running the simulation may 
require you to refer to Epanet for more information. 
 
V. Transmission Line Design 
 
To design the transmission line the following requirements must be satisfied:  

 
i. A network which contains one reservoir and one tank. 

ii. The transmission line segment from the reservoir and the tank can only be a 
straight line. (no loops, branches) 

 
Once these conditions have been met then the transmission line can be designed by going 
to the Tools menu and selecting “Design Transmission Line”  which will open up a dialog 
box prompting for the user to input a design flow rate for the transmission line.  Then the 
user needs to click on a node or pipe in the transmission line, which will cause the 
program to highlight the pipes of the transmission line.  Then the user may click “OK” to 
generate the network. 
 



 
 
The output of the design can be seen from the Data Grid tables as well as right clicking 
from the Graphical Display. The design can be run many times on the same project 
without any side effects for different flows etc.  

 
The transmission line designed minimizes the cost of the materials used to design the 
pipeline satisfying the flow constraints. 
 
VI . Simulation 
 
What is a simulation? 
A simulation in AguaRed consists of a set of trials in which each tap is set to either open 
or closed.  Each trial is completely independent from all other trials.  Also trials are 
instantaneous: they have no time component to them.  Whether or not a tap is open 
maybe be either set by the user or determined randomly.  In the later case, the probability 
with which a tap will be open is a function of the flow rate to that tap and the required 
flow rate.  An tap has an “event”  when it is open during a trial. 
 
Once the state of each tap for a trial has been determined, the network is turned over to 
the Epanet hydraulics engine.  Epanet then performs the calculations required to compute 
the flow rates, pressures, velocities, and headlosses through out the network.  The flow 
rates are then checked against the flow rate requirements.  A tap is said to have “ failed”  if 
it did not meet its flow rate during a given trial.  A trial is said to be a “ failure”  if a tap 
failed during that trial.  It is important to note that failures in this sense are not the 
catastrophes normally associated with engineering failures: nothing horrible will happen 
as a result of a tap failing in this sense; just not much water will come out of it.  However 
if a tap seems to fail consistently, it is probably worthwhile to do something to correct it.  
Otherwise whoever is using that tap is likely to experience poor performance and as a 
result will be very unhappy. 
 
To run a simulation… 
To run a simulation on a network, start the simulation wizard by selecting “Simulate…” 
from the Tools menu.  The first page of the wizard contains a brief welcome.  This page 



will contain error messages if there are problems with the design network that you are 
trying to simulate (i.e. disconnected nodes, missing materials).  The second page of the 
wizard is show below 
 

 
 
You must fill in the average flow rate per tap (in the units shown) and the peak factor 
before continuing.  The “Multiple probabilistic trials”  simulation type will run the 
simulation with all taps being set randomly.  The “Multiple probabilistic trials with 
specific subset”  option will allow you to set specific tap to always be open or closed.  To 
do this, click on the “Select Subset”  button after selecting the “Multiple probabilistic 
trials with specific subset”  option.  If checked, the “Remember all trials”  option will 
make it so that the details of every trial run is recorded so that they may be review later.  
If it is not checked, then only trials in which an error was encountered or a tap failed will 
be recorded. 
 
Barring any errors, clicking next will bring you to the screen shown below.  This screen 
indicates how much process has been made in running the simulation, how much time 
has elapsed, and gives an estimate for how much more time is required for the simulation 
to complete.  The amount of time that it takes to run a simulation will vary widely 
depending on the size of the network and how well designed it is.  Generally speaking if a 
simulation seems to be taking an inordinate amount of time considering the size of the 
network it is probably, though not certainly, because there is a problem with the 
network’s design.  Note: if the network you are simulating has a large number of taps, the 
program may hang for a few moments before it begins to show progress.  (What is going 
on is that it is checking the water supply to each tap, which takes the same amount of 



time as running one trial per tap, so with a significant number of taps this can add up to a 
large amount of time). 
 

 
 
If an error is encountered that requires the simulation to be halted, a screen like this will 
be shown in place of the one above 
 



 
 
Clicking next will then bring you to a screen like the one shown below that will detail the 
errors. 
 

 
 



However if no critical errors are encountered, then the next button on the “Running the 
Simulation…” page will turn into a Finish button.  Clicking finish will close the 
simulation wizard and show the results browser. 
 
Reviewing Results 
After a simulation is completed and the simulation wizard closed, a results browser 
window like the one below will be shown. 
 

 
 
Depending on the results of the simulation, between one and three tabs will be shown at 
the top of the window.  The “Summary”  tab seen above will always be shown.  It gives 
an overview of the output data for each tap.  The columns shown in the summary window 
are editable by right clicking in the white space and selecting “Edit columns…” from the 
menu that appears.   
 



 
 
The “Errors and Warnings”  tab will be shown only if a problem was encountered with a 
specific trial.  It gives a list of errors that were encountered and which trial they were 
encountered on.  It may be necessary to refer to the Epanet documentation or export the 
network for simulation in the Epanet program to fully determine what is causing an error 
or what the message means.  The export may be done using the steps outlined in section 
IV.  It will then be necessary to manually set the emitters in Epanet to match the state that 
they are in during the trial in which the error occurred.  This state may be determined by 
selecting the error and then selecting “Tap States”  from the drop down menu at the 
bottom of the window and then clicking “Display”  (more on this after the discussion of 
the tabs is finished).  After opening the exported file in Epanet, set the emitter 
coefficients on each tap that is closed to be 0, and then click the lightning bolt on the 
toolbar to attempt to run the simulation trial. 
 



 
 
The “Trials”  or “Failed Trials”  tab will be shown if the “Remember all trials”  box was 
checked or if there were failures during the simulation.  It gives a list of trials and 
indicates which taps failed in them.  This list can be quite lengthy, so the program may 
hang for a moment or two when this tab is clicked on for the time while the list is 
prepared.  Also since the list can be so long, it may be difficult to find specific trials or 
sets of trials.  For that reason, the ability to filter the trials shown has been implemented.  
Click on the “Filter Trials”  button to add rules that govern which trials are displayed in 
this tab.  The pictures below show the filter edit dialog and the result of applying rules. 
 



 
 



 
 
At the bottom of each tab is a drop down menu and Display button that will allow you to 
view information in graphical form in the main window.  The summary tab’s menu 
contains minimums, maximums, and averages for the whole simulation, while the other 
tabs menus correspond to information about a specific tab.  Once a Display button is 
clicked, the main window will change to look something like this. 
 



 
 
The scale along the top of the window ranges from the minimum value in the network to 
the maximum in the units shown in the upper right corner.  The colors for the gradient are 
preset.  Both the scale and the colors may be changed in most cases.  To do this simply 
click on the gradient (color strip).  To clear the overlay from the network, click the “Clear 
Overlay”  button.  To display a different set of results, just click the display button in the 
results browser and the current overlay will be discarded in favor of the new one. 
 
VI I . Report Generation 
 
AguaRed has built-in report-generation features.  Reports can be output for three types of 
data: nodes data, pipe data, and general data.  “Node data” /”Pipe data”  is information 
pertaining to all the nodes/pipes in the network for which reports are being generated.  
This network corresponds to the project which the currently has open.  “General data”  
consists of metadata pertaining to the project (i.e. project name, author, date of creation, 
and comments). 
 
A single tab-delimited text file is generated for each type of data.  The user will be asked 
to name the output file just before the report is generated.  The file can then be opened in 
MS Excel, and the output data will be fit into columns automagically. 
 
The report generation features also allow users to save presets for their reports.  This will 
be useful because it saves users from having to re-select which information they’d like to 



see in their reports each time they want a report; they can simply load a saved preset 
instead.  This feature is documented in more detail below. 
 
Lastly, users can print a copy of the network they see on the screen to an image file in 
JPEG format.   
 
Step-by-step instructions to generate a report 
To generate a report, follow the following procedure: 
 
1.  Click Reports �  Generate…  This will open the “Generate Report”  window: 
 

 
 
2.  Select the tab that corresponds to the type of information you wish to output and 

check the boxes that correspond to that information.  For this example, let us assume 
that we want to generation information about pipes.  Thus, we click the Pipes tab and 
check the boxes we want to: 

 



 
 
3.  Click the “Save Pipe Report”  button to output and save the information to a text file. 

(the button is differently named in the “Nodes”  and “General”  tabs, but the 
functionality is exactly the same).  No particular file extension is necessary to open 
the file in MS Excel. 

 
4.  When you are finished with outputting the information you want, you may click 

“Done” to close the “Generate Report”  window.  However, you might wish to save 
which checkboxes you checked so that they can be reused in the future without you 
having to remember exactly which boxes you checked.  To do this, enter the name 
you wish to give the preset in the text box next to the “Add Preset”  button, then click 
the “Add Preset”  button.  The name cannot contain spaces or other illegal file name 
characters.  If you click on the drop-down box at the bottom left of the window, you 
will see that the preset is listed.  Clicking it will remove all checks on the current tab 
and load those saved in the preset. 

 



 
 

Step-by-step instructions to print the network to a jpeg file 
 
1. Click Reports �  Print.  This will open up a dialog box which lets you choose a name 

and directory for the image file.  Do not click “Save”  yet. 
 
2. After entering a name for the image file, move the dialog box to a position where 

none of it overlaps with the network window below it.  Then click “Save” .  For 
instance, positioning the dialog like this would work, and the screen shot below it 
shows an unacceptable configuration: 

 
Good: 



 
 
Bad: 

 
 
Note: we’ re sorry you have to go through step 2, but we were having problems with the 
OpenGL code to take bytes from what’s displayed on screen.  If you don’ t move the save 
dialog box out of the way of the network before clicking its “Save”  button, the dialog box 
will also be shown in the JPEG. 
 



What do the ID fields mean (e.g. Node ID, SID, Material ID, etc.)? 
The ID’s in the report generation windows refer to the IDs used by the database for 
individual objects, such as nodes, pipes, schedules, etc.  They are primarily a tool to help 
the internal organization of the network. 
 
Why are some checkboxes grayed out in the report generation window? 
These boxes are grayed out because a simulation has not yet been run (notice that all of 
those boxes pertain to simulation-based data).  Once you run a simulation, the window 
will allow you to check those boxes. 
 
Where and how are presets are saved? 
All presets are saved in the /Report Presets/Nodes or /Report Presets/Pipes directories.  
They have a .pre extension.  You may delete presets from these directories if you’ re sure 
you don’ t want them, but only do so while AguaRed is not running. 
 
Comments about repor ts  for  future developers of AguaRed 
This section contains information that might be useful to anyone who wants to change, 
add to, re-design, or drop the features outlined in this document. 
 

- ReportDialog.cs and ReportDialod.resx are the main files you need to look at.  It 
would probably also help to look at the classes in /Network/Types and the 
Network class.  ReportDialog.cs contains some useful comments that you might 
want to read before making changes. 

- All checkboxes and field names are hard-coded in the “Nodes”  and “Pipes”  tabs; 
the report dialog is about as knowledgeable as it can be about the classes that 
make up the network.  This is not a good thing 

- The checkboxes on the “Nodes”  and “Pipes”  tabs are named based on the field 
names they correspond to.  These field names come from the Node, Pipe, and 
InnerNode classes, as well as all classes that directly inherit from InnerNode 
(Junction, Reservoir, Tank, Tap, Valve). 

- The “General”  tab checkboxes are dynamically generated.  Right now the 
checkboxes generated correspond to the project’s metadata entered when the 
project was created 

 
We hope that AguaRed will move from a fairly hard-coded, monolithic program to a 
more modular piece of software in the future. As this process takes place, it would be 
wise to create a Reports module that separates the actual data from the GUI. The Reports 
module will be responsible for creating an appropriate data model. For example, it could 
generate a series of “sections”  that contain “ fields.”  ReportsDialog will then be 
responsible for dynamically translating from this data model to an interface for outputting 
the data. Whatever model is ultimately decided upon makes little difference; separating 
data from presentation (and program logic) is the main goal for the next phase of 
AguaRed development. 
 
VI I I . Glossary 
 



Correction Trackpoints: Location data which are taken at a fixed location throughout the 
duration of the survey used to correct the altitude data of the trackpoints taken in the 
survey 
 
Trackpoints: Location data taken (automatically) by the GPS unit while walking along a 
path in the survey. The trackpoints give an approximation of where the pipes are going to 
be installed. 
 
Waypoints: Location data points taken (manually) by the surveyor on the GPS unit 
marking off features such as the location of a tank, houses etc. 
 


